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Information contained in this manual is believed to be accurate and reliable. However, Evertz assumes no responsibility for the use thereof nor 
for the rights of third parties, which may be effected in any way by the use thereof.  Any representations in this document concerning 
performance of Evertz products are for informational use only and are not warranties of future performance, either express or implied. The only 
warranty offered by Evertz in relation to this product is the Evertz standard limited warranty, stated in the sales contract or order confirmation 
form. 
 
Although every attempt has been made to accurately describe the features, installation and operation of this product in this manual, no 
warranty is granted nor liability assumed in relation to any errors or omissions unless specifically undertaken in the Evertz sales contract or 
order confirmation.  Information contained in this manual is periodically updated and changes will be incorporated into subsequent editions.  If 
you encounter an error, please notify Evertz Customer Service department. Evertz reserves the right, without notice or liability, to make 
changes in equipment design or specifications. 
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1. OVERVIEW  

The Demodulator series is a complete hardware based solution for demodulating satellite compressed 
transport streams.  As more satellite providers are adding services, they need better modulation 
performance and, therefore, are moving their modulators to DVB-S2.   
 
Controlled by the industry leading VistaLINK® PRO, this series offers signal providers the capability to 
demodulate two Transport Streams out of a DVB-S2 L-Band feed in one slot card making it the smallest 
footprint demodulator in the industry.  
 
All demodulators are backward compatible with existing QPSK (DVB-S) modulators.  In addition, each 
demodulator offers quality measurement of the RF signal.  
 
Please note that the term 7780DM-LB series in this manual refers to the following products: 7780DM2-
LB, 7780DM2-LB-CA, 7780DM2-LB2, 7780DM2-LB2-CA, 7780DM4-LB and 7780DM4-LB4.  
 
Features 

• Demodulates both DVB-S & DVB-S2 signals  
• 1 to 4 L-Band input with loop through  
• 2 to 4 DVB-S2 Demodualtors  
• 4 ASI Outputs 
• Broadband operation – 925 to 2176MHz  
• Monitoring of RF Input parameters 
• Optional MPEG over IP output  
• Optional BISS and BISS E Decryption  
• Comprehensive signal and card status monitoring via card-edge display, or remotely through 

the Industry leading Evertz VistaLINK® PRO NMS system 
• Fully hot swappable from front of frame  

 
Summary of Card specific features and options: 
 

 7780DM2-
LB 

7780DM2-
LB-CA 

7780DM2-
LB2 

7780DM2-
LB2-CA 

7780DM4-
LB 

7780DM4-
LB4 

CARD SLOTS 1 2 2 2 2 2 

RF INPUTS 1 1 2 2 1 4 

TUNER/DEMOD 2 2 2 2 4 4 

MPEG OVER IP 
OUTPUT -- -- +IP OPTION +IP OPTION +IP OPTION +IP OPTION

DVB-CI 
MODULE -- DUAL -- DUAL -- -- 

Table 1-1: Product Chart 
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Figure 1-1: 7780DM-LB Series Block Diagram 
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2. INSTALLATION 

2.1. REAR PLATE DESCRIPTION 

Each of the modules in the 7780DM-LB series comes standard with companion +3RU rear plates. 
Figure 2-1 and Figure 2-2 provide an illustration of the 7780DM-LB Series rear plates.  For information 
on mounting the rear plate and inserting the module into the frame, see section 3 of the 7700FR 
manual. 
 

                          
Figure 2-1: 7780DM2-LB, 7780DM2-LB-CA, 7780DM2-LB2 and 7780DM2-LB2-CA Rear Plates 
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Figure 2-2: 7780DM4-LB and 7780DM4-LB4 Rear Plates 

 
 

2.1.1. 7780DM-LB Connectors 
RF IN: Input BNC connector for L-band output of a suitable LNB directly or via a 

suitable attenuator giving lighting and surge protection.   
 
RF (MONITORING) OUT/  
LOOP OUT: Monitoring output BNC is an L-Band RF output for monitoring of L-band 

satellites. 
 
ASI OUT: Four BNC connectors used to output ASI Transport Streams.  
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2.1.2. Ethernet Connection 
The 7780DM-LB Series uses 10Base-T (10 Mbps), 100Base-TX (100 Mbps) or Gigabit (1Gbps) twisted 
pair Ethernet cabling systems.  When connecting for 10Base-T systems, category 3, 4, or 5 UTP cable 
as well as EIA/TIA – 568 100Ω STP cable may be used.  When connecting for 100Base-TX systems, 
category 5 UTP cable is required.  The cable must be “straight-through” with an RJ-45 connector at 
each end.  Establish the network connection by plugging one end of the cable into the RJ-45 receptacle 
of the card and the other end into a port of the supporting hub. 
 
The straight-through RJ-45 cable can be purchased or can be constructed using the pin-out 
information in Table 2-1.  A colour coded wiring table is provided in Table 2-1 for the current RJ-45 
standards (AT&T 258A or EIA/TIA 258B colour coding shown). Also refer to the notes following the 
table for additional wiring guide information.  
 

Pin # Signal EIA/TIA 568A AT&T 258A or 
EIA/TIA 568B 

10BaseT 
or 100BaseT 

1 Transmit + White/Green White/Orange X 
2 Transmit – Green/White or White Orange/White or Orange X 
3 Receive + White/Orange White/Green X 
4 N/A Blue/White or Blue Blue/White or Blue Not used (required)
5 N/A White/Blue White/Blue Not used (required)
6 Receive – Orange/White or Orange Green/White or Green X 
7 N/A White/Brown White/Brown Not used (required)

Pin  
1 

 
8 N/A Brown/White or Brown Brown/White or Brown Not used (required)

Table 2-1: Standard RJ-45 Wiring Colour Codes 
 
Note the following cabling information for this wiring guide: 
• Only two pairs of wires are used in the 8-pin RJ-45 connector to carry Ethernet signals. 
• Even though pins 4, 5, 7 and 8 are not used, it is mandatory that they be present in the cable. 
• 10BaseT and 100BaseT use the same pins (a crossover cable made for one will also work with the 

other). 
• Pairs may be solid colours and not have a stripe. 
• Category 5 cable must use Category 5 rated connectors. 
 
The maximum cable run between the router and the supporting hub is 300 ft (90 m).  The maximum 
combined cable run between any two end points (i.e. router and PC/laptop via network hub) is 675 feet 
(205 m). 
 
Devices on the Ethernet network continually monitor the receive data path for activity as a means of 
checking that the link is working correctly.  When the network is idle, the devices also send a link test 
signal to one another to verify link integrity.  The rear panel is fitted with two LEDs to monitor the 
Ethernet connection.  
 
1000: This Amber LED is ON when a 100Base-TX link is last detected.  The LED is OFF when a 

10Base-T link is last detected (the LINK LED is ON). Upon power-up the LED is OFF as 
the last detected rate is not known and therefore defaults to the 10Base-T state until rate 
detection is completed.  
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LN/ACT: This dual purpose Green LED indicates that the card has established a valid linkage to its 
hub, and whether the module is sending or receiving data.  This LED will be ON when the 
module has established a good link to its supporting hub.  This gives you a good indication 
that the segment is wired correctly. The LED will BLINK when the module is sending or 
receiving data. The LED will be OFF if there is no valid connection. 

 
 
To successfully install any of the 7780DM-LB series modules you will need: 
 

1. Unused IP address on the network or a DHCP server. 
2. Evertz serial cable. 
3. VLPro Server IP address. 

 

 
The 7780DM-LB series modules may be controlled directly via a built on SNMP 
agent or they may be controlled via a 7700 Frame controller. 

 
Control: Ethernet remote control port for SNMP control.   
 
Data:  RJ-45 high speed data (Transport Stream) over Ethernet output (option).   
 
 

2.2. HARDWARE INSTALLATION 

Before handling the card it is important to minimize the potential effects of static electricity. It is 
therefore recommended that an ESD strap be worn.  Locate on a 7700 chassis 2 adjacent vacant slots. 
Unpack the 7780DM-LB and separate the rear panel from the main card. Locate on the rear of the rack 
the three slots and remove the blanking panels. Insert the rear panel into the back of the chassis and 
secure using the screws provided.  
 
Before inserting the front card, connect the serial cable to the board using the serial cable provided. 
Now insert the 7780DM-LB Series card into the corresponding front slots ensuring the card lines up 
with the slot runners on the bottom and the top of the chassis. Push the card into the slot ensuring that 
when it mates with the rear card that is has been firmly pushed into a seated position. This can be 
confirmed when the connectivity lights for the Ethernet port are illuminated. Do not connect any cables 
to the rear card (failure to do this could cause unwanted network issues) until the initial configuration 
has been completed. 
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2.3. CONNECTING TO VLPRO 

This chapter assumes that the VLPro server and VLPro client are already configured for your network 
and you have basic knowledge of the VLPro interface. It also assumes that the user or network 
administrator has already added the 7780DM-LB series jar file to the server and both the client and 
server applications have been restarted. If you are the network administrator refer to section 5.2 for 
information on updating the VLPro Server Jar File. 
 
Open VLPro and click on the refresh tree icon. Expand the hardware tree by clicking on the “+” symbol. 
The 7780DM-LB should appear as a newly listed device with the IP address used to configure the card 
in Step 1 above or in the case where a Frame Controller is used it will appear under the FC IP address. 
It may take up to a minute to appear while the card and switch negotiate network settings (this can be 
verified directly on the switch if necessary). 
 
 
Figure 2-3 identifies the parameters of the 7780DM-LB Series as it will appear if controlled via a Frame 
Controller:  
 

 
Figure 2-3: VistaLINK® PRO Hardware Configuration 
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Note: If after a couple of minutes the card has still not appeared, try selecting 
Add Agent from the Tree> Add/Update Agent menu. Enter the IP address used 
in the configuration stage earlier and select OK.  The card should now be listed 
and will remain greyed out for a moment while VLPro finds the card and 
confirms its configuration. 

 
Please consult your network administrator if you continue to have problems connecting the card with 
VLPro, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical support. 
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3. TECHNICAL DESCRIPTION 

3.1. SPECIFICATIONS 

3.1.1. RF Inputs 
RF Inputs:  1 to 4 
Connector:  75Ω BNC (F-Type optional) 
Channel Bandwidth:  27,33,36,54 and 72MHz 
RF Input Range:  925 to 2176MHz 
Symbol Rate: 
 DVB-S  2 to 45 MSps 
 DVB-S2  10 to 30 MSps 
Input Power:  -69 to -23dBm 
 

3.1.2. Output Specifications 
Standard Outputs:  4 ASI BNC outputs 
 
MPEG over IP Output: (+IP Option): 
 MAC 802.3> IPV4> RTP> UDP> MPEG-2 TS 
 FEC PRO MPEG Forum Code of Practice #3, Rev 2 
 RJ45 10/100/1000 Connector 
 

3.1.3. Control Specification 
Connector:  1xRJ45 10/100 control port 
 
 

3.1.4. Monitored Parameters 

• Demodulator Sync indicator 
• Viterbi or LDPC Sync indicator (Depending on mode) 
• RS or BCH Sync Indicator (Depending on mode) 
• RF Signal level 
• Corrected bit rate 
• Uncorrected frame rate 
• ESNO count (SNR) 

 

3.1.5. DVB-CI compatible CA Module with (when fitted) 
• Alphacrypt 
• Aston Crypts 
• Conax 
• Cryptoworks 
• Irdeto 
• Nagravision 
• Viaccess 
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4. CARD CONFIGURATION 

Right click the 7780DM-LB series card in the side bar navigation tree and select “View Configuration”. 
The configuration page will open; it is from these configuration tabs that the 7780DM-LB can be 
configured. Refer to the relevant section of this manual for an explanation of the features and functions. 
  
4.1. DEMOD 

The Demod selection tab is used to tune each individual demodulator as well as monitor the health and 
status of the input signal.  The 7780DM-LB series cards can contain up to four different demodulators 
on each module. 
 

 
Please note that the following sections 4.1.1 to 4.1.4 outline the features for the 
7780DM2-LB2.  

 

4.1.1. Monitor Window 
The monitor section, as shown in Figure 4-1, displays the monitoring parameters for the selected 
demodulator. 
 

 
Figure 4-1: Monitor Window 

 
 RF Power Level: Measures the input power level. The input power level is –82 dBm to –19dBm.  

 
 PLL Locking Status:  Allows the user to monitor the PLL locking status (Not Locked, OK). 
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 Demod Locking Status:  Allows the user to monitor the demodulator lock status (Not Locked, 
OK).  

 
 Viterbi Locking Status:  Allows the user to Viterbi locking status. If the Viterbi decoder is able 

to lock correctly the Status field will display OK.  If it is unable to lock, the status will display Not 
Locked. 

 
 R-S Locking Status: Allows the user to monitor the Reed Solomon locking status.  If the RS 

decoder is able to lock to RS the Status field will display OK.  If it is unable to lock, the status 
field will display Not Locked.  

 
 Channel Es/No: This field shows the ratio between the average energy per transmitted symbol 

and single sided noise power spectral density. For a summary of performance requirements at 
QEF over AWGN, please refer to Table 13 in ETSI EN 302 307 v1.1.1 (2005-03) 

 
 Corrected Bit:  This field shows the count of the number of bits corrected by the Reed-

Solomon decoder (DVB-S mode) or BCH decoder (DVB-S2 mode).   This value is bit accurate 
only if all bit errors have been corrected.  

 
 Uncorrected Frame: This field shows the count of the number of frames that still have 

uncorrected errors in them. Thus if this value is zero, the corrected Bit value is accurate.  
 
 CRC Frame:   This count is only relevant in DVB-S2 modes and is a count of the number of 

CRC frame errors. 
 
 LNB PLL OffSet: This field shows the difference between the incoming frequency and the 

locked-to frequency.  
 
 

 
NOTE: If the card is removed from the chassis, the ASI loop through will continue 
but the decoded output will no longer be available. 

 



7700 MultiFrame Manual 
7780DM-LB Series DVB-S2/DVB-S Dual & Quad Demodulator with L-Band Inputs 

Page 16 Revision 1.0  

4.1.2. Control Window 
The control section, as shown in Figure 4-2, displays the controlled parameters for the selected 
demodulator. The user can configure the demodulator by entering the desired information into the 
parameter fields.  
 

 
Figure 4-2: Control Window 

 
 Satellite Frequency (GHz):  This field enables the user to enter the Satellite Frequency (GHz) 

value.  
 
 LOF Frequency (GHz):  This field enables the user to enter the standardized Local Oscillator 

Frequency (LO) value.  
 
 Lband Frequency (MHz):  This field enables the user to enter the L-band frequency. The input 

ranges from 925 to 2176 MHz. 
 

 
Note: Lband Frequency = Satellite Frequncy  - LOF Frequency 
Standardised LOF is 5150 for C-Band and 10750 for Ku-band.  

 
 

 Symbol Rate (KSps):  This field enables the user to enter a symbol rate in Ksymbols/s.    
 
 Operation Mode: Using the drop down menu, select the Modulation technique (DBS, DVB, 

QPSK, 8PSK) and the FEC ( ½, 2/3, 4/5, 3/5, 8/9, 7/8, 6/7, ¾, 5/6) rates.    
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Figure 4-3: Operation Mode 

 
 Roll-Off Factor: Use the drop down menu to select the transponder filter roll-off factors. The 

following options are available: 0.2, 0.25 and 0.35.  
 
 Spectral Inversion:   Use the drop down menu to select the Spectral Inversion. The following 

options are available: Normal, Inverted and Auto.  
 
 Normal: Scan only the un-inverted side of the frequency spectrum.  

 
 Inverted: Scan only the inverted side of the frequency spectrum.  

 
 Auto:  Scan both the inverted and un-inverted side of the frequency spectrum.  

 
 Pilot:  Use the drop down menu to enable or disable the pilot.  The following options are 

available: ON or OFF.  Select ON if pilot tone is present, otherwise this option should be set to 
OFF.  

 
 PL Scramble Code:   This field enables the user to set the physical layer scrambling code.  

 
 Frequency Search Range (KHz): This field enables the user to set the maximum frequency 

offset which is covered by the carrier search (in KHz).  The Frequency Search range is +/- 
10MHz.  
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4.1.3. Fault Trap Enable 
The Fault Trap Enable window allows the user to Enable (Check) or Disable (Uncheck) SNMP alarms 
from being sent from the module to the SNMP alarm server.  
 

 
Figure 4-4: Fault Trap Enable 

 
4.1.4. Fault Trap Status 
All LEDs can be used in auto refresh mode or on a graphical view to provide an instantaneous feed 
which relays information about the status of the input signal.  
 
The Input Loss LED is used to indicate the presence or loss of an input signal.  The remaining 4 LEDs 
can be used to represent the lock status for each demod.   
 
 

 
Figure 4-5: Fault Trap Status 
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5. TROUBLESHOOTING 

5.1. VLPRO DOES NOT DISPLAY THE 7780DM-LB ALARMS 

The user must connect directly to the board via the serial port. Once a connection has been 
established, check and/or configure the SNMP settings with the correct VLPro Server IP address and 
ensure the community strings are correctly set. Refer to the network administrator if you are in doubt as 
to what these should be set to. 

 

5.2. UPDATING VLPRO SERVER JAR FILE  

Products from Evertz are constantly evolving and new features are often added. It is therefore 
important to update the JAR files in use to provide access to all the latest features or enhancements. It 
will also be necessary to add JAR files for new products. If your new product has not appeared, even 
after waiting a few minutes for the Ethernet switch negotiation to complete, then it is possible that your 
JAR file may be old or missing. 

 
To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed 
will automatically be disconnected as soon as the VLPro Server is restarted). Maximize the VLPro 
Server window from the Windows task bar; select Help> Apply Update> Product from the menu.  

 

 
Figure 5-1: VistaLINK® PRO Server  
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A window will appear, as shown in Figure 5-2, simply navigate to the location of the new JAR file and 
double click to select the file. The window will automatically close and the update will be applied in the 
background.  

 
Figure 5-2: VistaLINK® PRO – Applying JAR Updates 

 
You will be prompted to restart the server to enable the change to take effect. Apply as many JAR 
updates as required before restarting the server. 

 

 
Figure 5-3: “Please Restart Your Alarm Server” Dialog Box 

 

 
NOTE: You may confirm that all updates have been successfully applied by 
selecting from the menu Tools>View>Show/Hide Product update log. 

 
Shutdown the server by selecting from the menu: File>Shutdown Server. Now re-open the server, it is 
normal for the startup to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VLPro Clients. As the Client restarts you will experience a short delay 
while the update is applied. A prompt will appear confirming that the updates have been applied. 
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6. ABBREVIATIONS 

For the purposes of the present document, the following abbreviations apply: 
 
BAT Bouquet Association Table 
BER  Bit Error Rate 
BW  Band Width 
CA  Conditional Access 
CAT Conditional Access Table 
CPE Common Phase Error 
CRC  Cyclic Redundancy Check 
ETSI European Telecommunications Standards Institute 
DC  Direct Current 
DVB  Digital Video Broadcasting 
DVB-C  Digital Video Broadcasting baseline system for digital cable television (EN 300 429 [6]) 
DVB-CS  Digital Video Broadcasting baseline system for SMATV distribution systems (EN 300 473 

[13]) 
DVB-S  Digital Video Broadcasting baseline system for digital satellite television (EN 300 421 [5]) 
DVB-T  Digital Video Broadcasting baseline system for digital terrestrial television (EN 300 744 

[9]) 
EIT  Event Information Table 
ETR  ETSI Technical Report 
ETS  European Telecommunication Standard 
FEC  Forward Error Correction 
GOP Group of Pictures 
HEX  Hexadecimal 
ISO  International Organization for Standardization 
ITU  International Telecommunication Union 
MGT Master Guide Table 
MPEG  Moving Picture Experts Group 
NIT  Network Information Table 
PAT  Program Association Table 
PCR  Program Clock Reference 
PID  Packet Identifier 
PMT Program Map Table 
PSI  MPEG-2 Program Specific Information (as defined in ISO/IEC 13818-1 [1]) 
PSIP Program and System Information Protocol 
PTS  Presentation Time Stamps 
RS  Reed-Solomon 
RST  Running Status Table (see EN 300 468 [7]) 
RTE Residual Target Error 
SDT  Service Description Table 
SI  Service Information 
TDT  Time and Date Table 
TOT  Time Offset Table 
TS  Transport Stream 
UTC  Universal Time Co-ordinated 
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